
NEWSLETTER #71 - October 2018

We aim to put you in a DAYS this month as we show 
you how to calculate the number of times a particular weekday occurs in a month.  I suppose with the A to Z of Excel Functions this 
month, we have financial modelling pretty much COVAR’d (groan – Ed).

Our new series on VBA, Visual Basics, continues joining Power Query Pointers, the Keyboard Shortcuts and all of the 
Power BI updates.  With further news on the book and how to get it, there’s plenty to feast upon.

Happy reading and see you next month.

Finally!  Kudos to the team as we have finally got our proverbials together and listed Introduction to Financial Modelling on Amazon (so far, listed on 
the Australian website but we are working on others!).

This book was instigated by the author, Excel MVP Liam Bastick's 
belief that there was no definitive book on the market to show would-
be modellers how to initiate development of a three-way integrated 
financial model.  it takes readers through what are the key Excel functions 
and features (and why), and then explains the rationale of why a model 
should be built in a particular way in a particular order.  Liam has built 
models for over 30 years now and wants to share the secrets of Keep It 
Simple Stupid!

Based on many of our training courses, this simple book explains how to 
avoid many of the trials, traps, tribulations and pitfalls of modelling in a 
structured, concise and transparent manner.  The Table of Contents is 
detailed here.  

Although aimed at those with just some knowledge of accounting 
/ finance and Excel, even more advanced users have provided the 
feedback, "...I wish someone had shown me this when I first started out".

For those who would rather order it directly, it can still be purchased 
from us too, simply drop us a line at contact@sumproduct.com for more 
details.

Amazin’ Amazon Book…
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If you would like to catch up with us, drop us a line at contact@sumproduct.com and we’ll try to swing by.  If you’re elsewhere, we might be on our 
way soon – with journeys lined up to almost anywhere with a vowel in it (sorry Poland).  More details soon…

October is another hectic month for us.  It kicks off with trips to Manila, Milan and London, with CPA Australia events around Australia too – 
combined with our usual Excel training.  And that’s just what it looks like at the time of writing!

We often get asked by my clients “…can I do this?” or “…can I do that?” in Excel.  I have yet to find something that Excel has not managed to solve.  
No doubt there’s a reader out there that can stump us but we haven’t found them yet!

Often, when building monthly forecasting models, one or more days of the week may be a key driver of analysis.  For example, pubs and bars may 
find their highest takings are on Fridays and sporting events may have greater attendances at the weekends, etc.  Therefore, modellers often need 
to know how many Fridays (say) there are in any particular month.

The answer is:

=4+(DAY(DATE(year, month,35))<WEEKDAY(DATE(year,month,1)-weekday_number))

However, I think I need to provide a little more explanation.

To calculate this, I will need to use a particular Excel function, WEEKDAY(serial_number,[return_type]), which has the following arguments:

• serial_number: this is a required sequential number that represents the date of the day you are trying to find.  Dates should be entered by  
 using the DATE function, or as results of other formulas or functions.  Problems can occur if dates are entered as text;
• return_type:  this is a number that determines the type of return value.  By default (or if not entered), this will return a value of 1 for Sunday,  
 2 for Monday, through to 7 for Saturday.  I recommend not changing this default as this can cause problems with earlier versions of Excel.

But before I explain how this is used, let me explain my rationale for 
the calculation.

The whole underlying concept revolves around the five week month.  
If there were five weeks / 35 days in each month, then it would 
not matter which day of the week you chose.  There would be five 
Tuesdays, five Saturdays and so on.  Similarly, if each month only had 
four weeks / 28 days, like a non-leap year February, any particular 
would occur four times in the month.  The problem is, the number of 
days in the month lies between 28 and 31 days.

Therefore, I consider what “date” the 35th of a particular month is.  
For example, June has 30 days, so 35 June is actually 5 July, so the 
date would be 5.  That means there would be two days of the week 
(7 – 5) that would occur five times in June, specifically whatever day 
1 June and 2 June fall on.

Therefore =7-DAY(DATE(year, month,35)) tells us how many days of 
the week will occur five times for a given month and year.  It is this 
idea I will expand upon.

=WEEKDAY(DATE(year,month,1))

tells me what day of the week the first day of a given month and year is.  
If it were Tuesday, for example, and =7-DAY(DATE(Year, Month,35)) is 
equal to 3, this would mean there were five Tuesdays, Wednesdays and 
Thursdays in that month (i.e. Tuesday 1, 8, 15, 22 and 29; Wednesday 2, 
9, 16, 23 and 30; Thursday 3, 10, 17, 24 and 31).

I’m nearly there; the following formula gives us what we need.

=4+(DAY(DATE(year,month,35))<WEEKDAY(DATE(year,month,1)-
weekday_number))

Out and About in October

Friday on My Mind
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Let me explain:

• The 4 at the beginning is the minimum number of occurrences   
 of a particular day in any given month.  Yes, I don’t like it’s been  
 hardcoded either.

• The remainder is a condition, which will either be TRUE or FALSE.   
 Now 4 + TRUE = 5 whilst 4 + FALSE = 4, so this condition evaluates  
 if the fifth occurrence will happen.

• As discussed above, DAY(DATE(year, month,35)) will give rise to a  
 value of 4, 5, 6 or 7, depending upon whether there are 31, 30, 29  
 or 28 days in the month respectively.  That is, for these numbers  
 of days, there will be 3, 2, 1 or zero days which occur five times.

• If WEEKDAY(DATE(year,month,1)) is the weekday_number of   
 the day of the week being considered, then DATE(year,month,1)- 
 weekday_number will always return the date of the last Saturday  
 of the prior month.  

• For example, 1 April 2020 is a Wednesday and it is the number   
 of Wednesdays we want to count in April.  The weekday_number  
 of Wednesday is 4; four days before 1 April 2020 is 28 March  
 2020, which is the last Saturday of the prior month; WEEKDAY(28  
 March 2020) is 7.  DAY(DATE(2020,4,35)) is 5, and since 5 < 7,  
 there will be five Wednesdays in April 2020.

• If the day of the week being considered is the second day of the  
 given month, then DATE(year,month,1)-weekday_number will   
 always return the date of the last Friday of the prior month.  

• For example, 1 February 2020 is a Saturday and let me assume   
 we are considering how many Sundays there are in February 2020  
 (i.e. Sunday is the second day of the month).  The weekday_ 
 number of Sunday is 1; one day before 1 February 2020 is   
 31 January 2020, which is the last Friday of the prior month;   
 WEEKDAY(31 January 2020) is 6.  DAY(DATE(2020,2,35)) is 6,   
 and since 6 is not strictly less than 6, there will be four Sundays in  
 February 2020.

• Similarly, if the day of the week being considered is the third day  
 of the given month, then DATE(year,month,1)-weekday_number  
 will always return the date of the last Thursday of the prior month. 

• For this final example, 1 October 2020 is a Thursday and let   
 me assume we are considering how many Saturdays there are in  
 October (i.e. Saturday is the third day of the month).  The   
 weekday_number of Saturday is 7; seven days before 1 October  
 2020 is 24 September 2020, which is the last Thursday of the prior  
 month; WEEKDAY(24 September 2020) is 5.     
 DAY(DATE(2020,10,35)) is 4, and since 4 < 5, there will be five   
 Saturdays in October 2020.

• Hence this formula will count the number of occurrences of a   
 particular weekday for a given month and year.

There are issues with the above formula:

• The formula cited assumes WEEKDAY() is used with its default  
 settings (Sunday = 1, Monday = 2, …, Saturday = 7).  If this is   
 changed, the formula will need to be revised accordingly;

• The Earth goes around the sun once every 365.2422 days (I am  
 available for trivia nights!) and hence not every fourth year is  
 a leap year.  If a year ends in ‘00’ (e.g. 2000), the year must be   
 divisible by 400 – not four – to be a leap year.  However, Excel’s  
 dates / serial numbers do not work like this “…to be compatible  
 with Lotus 1-2-3…” so this formula should only be used for months  
 between January 1901 and December 2099.  Hopefully, this is an  
 acceptable limitation…

• Given how serial numbers used to differ between the Macintosh  
 and Windows operating systems, be careful of using this formula if  
 end users will be using both of these systems.

• And finally, please don’t write in to comment on the existence of 
 hard code in the given formula.  Regular readers will note I abhor  
 hard code (other than 0 or 1) in formulae, but where a number   
 cannot change (as here in two instances with 4 and 35), hopefully  
 you will accept I “tolerate” this exception!

It’s not all about the Power Tools, you know.  We thought we’d run a new elementary series going through the rudiments of Visual Basic for 
Applications (VBA) as a springboard for newer users.  This second part looks at how to record a macro.

Recording a macro is pretty straightforward and is the typical well users get their feet under the table with VBA.  There are several ways you can do this:
 1. From the ‘View’ tab on the Ribbon
 2. From the ‘Developer’ tab on the Ribbon
 3. From the Status Bar
 4. Keyboard shortcut.

Let’s take a brief look at each in turn. 

1. From the ‘View’ tab on the Ribbon

In the ‘View’ tab of the Ribbon, there is a category called ‘Macros’ with a ‘Macros’ button, funnily enough.  Click on the button and a drop-down 
menu will appear.  Select ‘Record Macro…’.

Visual Basics
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2. From the ‘Developer’ tab on the Ribbon

Similarly, in the ‘Code’ grouping on the ‘Developer’ tab and then select ‘Record Macro’, viz.

3. From the Status Bar

We can find a small button next to the word ‘Ready’ in the status bar at the bottom of Excel.

4. Keyboard shortcut

Perhaps not the easiest keyboard shortcut in the world to remember, ALT + W + M + R activates the first method (‘View’ tab on the Ribbon).  It also 
stops the macro recording.  This keyboard shortcut isn’t pretty, but it’s robust.  The ‘Developer’ tab isn’t always on the and the status bar has no 
readily accessible shortcut.

After pressing a “Record Macro” the Record Macro dialog box will appear.  
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Each month we’ll reproduce one of our articles on Power Query (Excel 2010 and 2013) / Get & Transform (Excel 2016) from www.sumproduct.com/
blog.  If you wish to read more in the meantime, simply check out our Blog section each Wednesday.  This month, we look at a way of extracting 
data from groupings.

Following on from last month, despite having simplified my data into groupings, we can still access data that makes up the group to provide more 
information.  At the end of last month’s Power Query Pointer, we had made some changes to a query of mine, ‘ACCT_Order_Charges_with_Group’.  
We will be making more changes, but to avoid causing problems to the grouping query, let’s create a copy of the query.  Here, the example has 
already taken the grouping a step further to show which item group is the best seller:

The easiest way to make a copy of the query is in the Excel workbook.  The ‘Workbook Queries’ pane should be displayed (if it’s not, use the ‘Show 
Pane’ option on the ‘POWER QUERY’ tab, or in the ‘Get and Transform’ section).  Right clicking my query gives me the option to ‘Duplicate’ it.

Next, we will duplicate the query, and give it a new name ‘Order_Charges_Summarising’:

Power Query Pointers
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Now, suppose we were at this stage and we needed to find out the most expensive selling item in each item group.  We would need to see the data 
behind the grouping, and to do this we would need to modify the grouping step.  Therefore, click on the gear icon next to the ‘Grouped Rows’ step 
and add a column (‘aggregation’) ‘Details’ which will act on all rows:

Clicking ‘OK’ gives us a new column, which contains tables.  Clicking on the word ‘Table’ has two effects.  Firstly, we get a warning because other 
steps exist after my ‘Grouped Rows’ step and secondly, we see the contents of our table viz.
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The warning reminds us to remove the last two steps, which we can do since they were only introduced to tidy up the grouped data.  Having 
removed them, we need to find a way to get at the data in the tables so that we can work out which item was the most expensive selling item in 
each item group.  We are going to need a custom column, using a record.  The formula we will use is 

= Table.Max([Details], "Amount")

Clicking on any record will show us what is in it (and creates a step):

Since we have chosen to use a record, what is shown is not just the most expensive item in the group, but also the other data associated with that 
item, in effect a row within a row.  Let’s delete the last step and go back to the ‘Added Custom’ step.  Then, choose to use the expand icon next to 
the MaxRecord column name to expand all of the records:
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We only want the ‘Amount’ and ‘Description’ and we’ll keep the column names for now. 

What we have now is the description of the most expensive item in each group, and the price for that item, so let’s change the names accordingly, 
remove the Details column and reorder ready to load.

This is a simple example of getting data from records when the data has been grouped.

More next month!

The pace of change continues, but the volume may be decreasing slightly.  No matter: this month’s updates include Previews of aggregations and a 
PDF file connector, which are both likely to prove popular.

The September updates are as follows:

September Updates for Power BI Desktop

•	 Dot	plot	layout	support	in	scatter	charts
•	 Copy	value	and	selection	from	table	and	matrix
•	 Built-in	report	theme	options
•	 Report	page	tooltips	Generally	Available	and	Card	support
•	 Accessibility	improvements	for	analytics	and	formatting	pane	support

•	 Aggregations	(Preview)
•	 Q&A	support	for	RLS

Reporting

Analytics
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•	 PDF	file	connector	(Preview)
•	 SAP	BW	connector:	support	for	measure	properties
•	 Dataflows	connector	(Beta)

•	 M	intellisense	(Preview)
•	 Add	Column	From	Examples:	support	for	text	padding

You	know	the	routine	by	now.		Let’s	go	through	each	new	feature	in	turn.

To start, there’s a substantial update to the scatter chart with this update.  You can now use categorical fields on the x-axis of your scatter chart, 
allowing you to create dot plots.  You don’t need to do anything special to enable this feature, simply add your categorical field to the x-axis and 
remove anything you may have in the detail’s bucket. 

You can do this in combination with all of the formatting features and it works with drilling on the x-axis too.

Data Connectivity

Data Preparation

Dot plot layout support in scatter charts
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It’s no secret that many users need to copy data out of Power BI into 
other applications like Dynamics CRM, Excel and even other Power BI 
reports.  Microsoft’s first feature related to this is the ability to copy a 
specific value or a selection of data from a table or matrix.  You’ll be able 
to find both of these options on the right-click menu.

‘Copy value’ will add the unformatted value to your clipboard, and from 
there you can paste it wherever you want.  For example, ‘copy value’ 
from this cell in the table (below) will add 32,130 to the clipboard.

‘Copy selection’, on the other hand, will add a tabular version of all data 
currently selected in your table or matrix to the clipboard, including the 
row and column headers.  The data will retain the data formatting that 
has been applied and subtotals will be excluded.  This option is very 

useful if you want to reuse a selection of data in another report in Excel 
for some quick calculations. 

For example, if you have the entire ‘Economy’ column selected in the 
matrix (below) and pick ‘Copy selection’:

You will get all of this data in a tabular format when pasting into Excel:

Copy value and selection from table and matrix
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Note that when you have multiple measures in your matrix, they are always selected together, so you’ll always get both when copying selection.  For 
example, copying the below selection

Next up is a themes gallery in the Desktop that allows you to pick between several built-in report themes.  You’ll be able to see these new theme 
options under the ‘Switch Theme’ button in the ‘Home’ Ribbon tab.  In addition to the default theme, you can now pick between seven new options:

will add the following to your clipboard:

Microsoft has actually advised they have more planned for copying in future releases as well, including the ability to copy all loaded data to the 
clipboard in its pivoted layout, copying data out of other visuals, and copy visuals between .pbix files.  Looking good.

Who needs Power Query?  

Built-in report theme options 
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All you need to do is pick the theme of your choice and it will automatically apply its color (sic) palette to all of your visuals using the default color 
palette.  There is now also a quick link to the theme gallery in the community site if you want to try out a theme built by others.

This update sees report page tooltips become Generally Available.  This means you’ll be able to use the feature without needing to enable it in the 
‘Options’ dialog.  To go along with making it Generally Available, Microsoft is also adding support for report page tooltips on the Card visual. 

In this update, as part of enhancing assistive technology, Microsoft has 
added keyboard and screen reader support for the ‘Formatting’ and 
‘Analytics’ panes.  If your focus is in the ‘Formatting’ pane or ‘Analytics’ 
pane, you’ll be able to TAB and SHIFT + TAB between all the controls, 
hear useful information read out by a screen reader for any given 
control, and change the settings using arrow keys and SPACE / ENTER 
depending upon the control type.  There will be further support added 

to the other areas of the pane, including the ‘Field’ well and ‘Filter” pane 
in the coming months as well. 

Just like any other accessibility improvement, this update improves the 
experience for all users as well.  Many power users will find the keyboard 
navigation will allow them to work a bit faster when making many 
changes to a visual’s formatting all at once. 

Aggregations are a way to store only summarised values in memory, to 
provide the fastest access to aggregated data without having to load 
your entire dataset into Power BI.  We have to be honest, this has been a 
problem in consulting projects we have encountered so far.

For example, a trillion rows from a Hadoop store might take up ¼ petabyte, 
but caching the values aggregated up to a daily level might reduce that to 

a few gigabytes which can be cached in memory much more easily.  The 
magic is that this is seamless to the report users – as they slice further 
down to the detail level, if Power BI doesn’t have the answer in memory 
it automatically passes the query down to the underlying source using 
DirectQuery.  Using aggregations can dramatically reduce the cost of 
unlocking large datasets for decision making in enterprise organisations.

Report page tooltips Generally Available and Card support

Accessibility improvements for analytics and formatting pane support

Aggregations (Preview)
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Some benefits of aggregations include:

• Query performance over large datasets. As you interact with visuals on Power BI reports, DAX queries are submitted to the dataset.   
 This will boost query speeds by caching data at the aggregated level using a tiny fraction of the resources that would be required at the detail  
 level. This will mean users may unlock big data in a way that would not otherwise be possible
• Data refresh optimisation.  You will be able to reduce cache sizes and refresh times by caching data at the aggregated level.  This will reduce  
 the time required to make data available for users
• Achieve balanced architectures.  This allows the Power BI in-memory cache to handle aggregated queries, which it is generally efficient with.   
 This will limit queries sent to the data source in DirectQuery mode, helping stay within concurrency limits.  Queries that do get through tend  
 to be filtered, transactional-level queries, which data warehouses and big-data systems normally handle these well.

Here’s an example to show how aggregations are set up.  Let’s say we have a model where all the tables are DirectQuery.  The Sales fact table contains 
billions of rows.  Setting the storage mode of Sales to ‘Import for caching’ would consume considerable memory and management overhead.

Instead, we create the ‘Sales Agg’ table which will become our aggregation table.  It is at a higher grain than the ‘Sales’ table, so it will contain far 
fewer rows.  The number of rows should equal the sum of SalesAmount grouped by Customer, Date and Product Subcategory keys.  Instead of 
billions, this might be millions of rows, which will be much easier to manage.

The dimension tables most commonly used for the queries with high business value are set up so the tables that can filter ‘Sales Agg’ using one-to-
many (or many-to-one) relationships.  In our case, that includes the Geography, Customer, Date, Product Subcategory, and Product Category tables.  
Other relationship types such as many-to-many or multi-source are not used for aggregations.
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Now that we have our table set up, we’ll set the storage mode of Sales Agg to ‘Import’ to speed up queries.

When we do this, we’ll be setting the storage mode to ‘Dual’, since we 
are mixing DirectQuery and Import sources.  Setting the storage model 
to ‘Dual’ allows the related dimension tables to act as either Import or 
DirectQuery depending upon the subquery.

Queries that aggregate metrics from the Sales Agg table, which is 
Import, and group by attribute(s) from the related ‘Dual’ tables will be 
returned from the in-memory cache.  However, queries that aggregate 

metrics in the Sales table, which is DirectQuery, and group by attribute(s) 
from the related ‘Dual’ tables will be returned in DirectQuery mode.  The 
query logic including the group by operation will be passed down to the 
source database.

Next, we define the aggregations by selecting the manage aggregations 
context menu for the Sales Agg table.

The ‘Manage aggregations’ dialog shows a row for each column in the Sales Agg table, where you can specify the aggregation behaviour. 
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After this, queries submitted to the Power BI dataset that refer to the Sales table are internally redirected to the Sales Agg table.  This means you 
can hide the Sales Agg table and other users of the dataset don’t need know the Sales Agg table even exists!

You can finally use Q&A and Row Level Security, which lets you configure 
your datasets and reports to only show rows of data that the current 
user should have access to, on the same dataset.  This means that your 
users will be able to ask natural language question over these datasets, 
and they will only see results and suggestions that the RLS rules allow 

them to see.  You can start testing it out now in Power BI Desktop using 
the ‘View as Role’ experience while using the Q&A explorer dialog or 
Q&A for report creation.  It’s rolling out to the Power BI service as we 
write...

This release sees a Preview of the PDF Connector.  Not before time!!  In order to try it out, you will need to enable it under the ‘Preview features’ 
list in the ‘Options’ dialog.  After enabling this Preview feature and restarting Power BI Desktop, the PDF File connector will appear under the ‘File’ 
category in the ‘Get Data’ dialog:

After selecting this connector, you will be prompted to specify a path to a PDF file.  Once the file is specified, Power Query will extract tables 
automatically and present them to you in the Navigator dialog, where you can preview and select one or multiple tables.

Q&A support for RLS

PDF file connector (Preview)
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Looking forward to this one!

A new capability added this month to the SAP BW Connector allows you to select additional measure properties when using the SAP BW connector 
in ‘Import’ mode.  Within the ‘Navigator’ dialog, you can now select one or multiple measure properties:

Dataflows are a powerful new addition to Power BI.  With dataflows, users can connect to multiple data sources and prepare their data for use in 
Power BI.  Dataflows are an integrated part of the Power BI suite; the dataflows desktop connector is now a part of Power BI Desktop allowing you 
to seamlessly connect to data carpeted by dataflows.

In the future, Microsoft plans to add this capability to SAP BW DirectQuery mode as well.

SAP BW connector: support for measure properties

Dataflows connector (Beta)
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With this release, Power BI Desktop includes a Preview of Intellisense 
support for the M language.  This support is available in the ‘Advanced 
Query Editor’ in this release.  In the future, Microsoft plans to add M 
Intellisense support for the Formula Bar and the ‘Custom Column’ dialog.  
To try out this new feature, you need to enable it under the ‘Preview 
features’ tab in the ‘Options’ dialog.

After the feature has been enabled and Power BI Desktop is restarted, 
you can leverage Intellisense within the ‘Advanced Editor’ in the ‘Power 
Query Editor’ dialog.  This includes syntax colouring, line numbers, 
function completions and parameter metadata for M library functions.

This update improves ‘Add Column From Examples’ by adding support 
for Text Padding transformations, which can now be composed 
with any other transformations in order to generate the right set of 
transformations to go from input columns to desired output based on 

user-provided samples.  Text Padding allows you to make values within 
a Text column conform to a fixed width by adding characters at the 
beginning or the end of the original value.

M intellisense (Preview)

Add Column From Examples: support for text padding
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More updates and intel next month we’re sure!

The new stuff keeps coming.  We’re feeling a little lazy this month so no categorisations:

• Multi-geo support for Power BI Premium (Preview)
• APIs and PowerShell Cmdlets
• Persistent filters on custom visuals
• New workspaces experience (Preview)
• Custom visuals API v1.1 and older deprecation
• Power BI Report URL filter improvements
• On-premises data gateway update
• Power BI Premium Capacity Monitoring (Preview)
• Single Sign-On in Power BI Mobile Windows App
• Phone report layout editing in Power BI Service
• Phone drill through now available for Table and Matrix visuals.

We’ll go through each in turn.  

Latest Updates for Power BI Service and Mobile

Back in the August newsletter, we mentioned the public Preview of 
Multi-Geo for Power BI Premium, which Microsoft viewed as their 
“next step” in helping multinational organisations address their data 
residency requirements.  This is important as organisations / businesses 
are extremely wary of where their data is located based upon legal 
regulations and commitments made to their own customers.  

With Multi-Geo, Power BI administrators can deploy a Premium capacity 
to one of nine geographical (“geo”) locations available globally.  For this 
current Preview, users’ Power BI datasets and cached queries are stored 
in the region selected for their capacity.  Additional metadata, such as 
dataset credentials and Excel workbooks, will still be stored in the geo 
associated with the Power BI tenant.  Microsoft plans to migrate this into 
Multi-Geo capacities soon.

Microsoft has just released a new set of Admin APIs, along with a .NET SDK and a PowerShell module, to help IT administrators effectively govern their 
Power BI deployment.  These new capabilities go beyond what is currently available in the Power BI Admin Portal and give administrators visibility 
into every aspect of their BI environments.  

Multi-geo support for Power BI Premium (Preview)

APIs and PowerShell Cmdlets

mailto:contact@sumproduct.com
http://www.sumproduct.com


contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

Our April newsletter detailed the introduction of persistent filters.  At that time, we noted that this feature was not supported for any reports that 
contain custom visuals.  Microsoft has now partially removed the restriction and officially support the following common custom visuals:

• Chiclet Slicer
• Hierarchy slicer
• Timeline slicer
• Attribute slicer

App workspaces play a vital role in collaboration and content 
management of reports, dashboards and datasets in Power BI.  Since 
its launch in May 2017, Microsoft has been collating feedback on these 
workspaces.  Consequently, a new Preview of the new workspaces 

experience has just been issued that makes it easier for organisations to 
manage access to workspaces through security groups, distribution lists 
and Office 365 groups.

Persistent filters on custom visuals

New workspaces experience (Preview)
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Hopefully all custom visual developers have migrated already, but since September 1, custom visual API versions 1.1 and older have been deprecated.  
Microsoft will only support API versions 1.2 and above.

This update has enhanced the URL filtering capabilities on reports to allow users to define more complex query string parameters.  This feature 
becomes useful when you want to create shortcuts to pre-filtered reports and provide hyperlinks to consumers.  URL filters follow the OData syntax 
and remain consistent to other filtering methods in Power BI.  Microsoft plans on bringing more improvements in this area soon.

The latest release of the On-premises data gateway continues to add improvements on the custom data connectors in the Enterprise gateway that 
was announced recently.

A new Preview has been launched of the Premium Capacity Monitoring 
application.  This app gives capacity administrators the ability to monitor 
the health of premium capacities and identify any issues that might affect 

the end users in their deployment.  Along with the system metrics, you 
can see a comprehensive view of dataset refreshes, dataset evictions 
and queries in the capacity for the past seven days. 

Custom visuals API v1.1 and older deprecation

Power BI Report URL filter improvements

On-premises data gateway update

Power BI Premium Capacity Monitoring (Preview)
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Single Sign-On (SSO) gives you access to all the applications and 
resources that you need to do business by just signing in once using a 
single user account.  Once signed in, you no longer need to authenticate 
your applications every time.  The Power BI Windows app, with its 
integration to Azure Active Directory, now enables you to use your 

primary organisational account to not only sign in to your domain-joined 
devices, but also to sign into Power BI Service congruently.  And before 
both of our readers write to us, SSO is enabled only for windows devices 
managed by Windows Azure AD – yes, we know…).

Microsoft has finally brought the phone report layout editing to the Service.  If you already published a report to Power BI Service, you can now create 
phone report layout directly from the Service.  All you need to do is switch to ‘Edit’ mode and find the ‘Mobile Layout’ option in the top bar, and your 
report’s phone layout will be in the Service.

Finally, for this month, the latest updates allow Table and Matrix visuals to support tooltips, enabling mobile users to get access to the drill actions.  
You should note that Tooltip is not enabled by default for these visuals, so make sure to turn it on in Power BI Desktop (or Service) to get the drill 
experience.

More anon…

To simplify the sign-in process, when you install the app for the first time, 
the app will automatically try to authenticate you to Power BI Service 
using SSO.  If this process fails, only then will the app ask you to provide 
credentials for Power BI.

Existing users that upgrade their app can use SSO by signing out, closing 
the app and re-opening it on their device.  You should notice that when 

you are re-opening the app, Power BI will automatically try to use your 
current windows credentials to authenticate against the service.  If you 
don’t want to use your currently Windows active session credentials to 
sign in to Power BI, just go to setting, sign-out and sign in with different 
credentials.

Single Sign-On in Power BI Mobile Windows App

Phone report layout editing in Power BI Service

Phone drill through now available for Table and Matrix visuals
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So what’s the COVAR story here?  Well, this is all about the measure of the 
linear relationship between random variables.  In probability theory and 
statistics, covariance is a measure of the joint variability of two random 
variables.  If the greater values of one variable mainly correspond with 
the greater values of the other variable, and the same holds for the lesser 

values, i.e. the variables tend to show similar behaviour, the covariance 
is positive.  In the opposite case, when the greater values of one variable 
mainly correspond to the lesser values of the other, i.e. the variables 
tend to show opposite behaviour, the covariance is negative.  

The sign of the covariance therefore shows the tendency in the linear 
relationship between the variables.  The magnitude of the covariance is 
not easy to interpret because it is not normalised and hence depends 
on the magnitudes of the variables.  The normalised version of the 
covariance, known as the correlation coefficient, however, shows by its 
magnitude the strength of the linear relationship.

This function returns covariance, the average of the products of deviations 
for each data point pair in two data sets.  It is used to determine the 
relationship between two data sets.  For example, you can examine 
whether greater income accompanies greater levels of education.

The COVAR function employs the following syntax to operate:

COVAR(array1, array2)

The COVAR function has the following arguments:

• array1: this is required and represents the first cell range of integers
• array2: this is also required. This is the second cell range of integers.

It should be further noted that: 

• this function has been replaced with two newer functions (COVARIANCE.P and COVARIANCE.S) that may provide improved accuracy and   
 whose names better reflect their usage.  Although this function is still available for backward compatibility, you should consider using the new   
 functions going forward, since this function may not be available in future versions of Excel
• the arguments must either be numbers or be names, arrays, or references that contain numbers
• if an array or reference argument contains text, logical values, or empty cells, those values are ignored; however, cells with the value zero are   
 included
• if array1 and array2 have a different number of data points, COVAR returns the #N/A error value
• if either array1 or array2 is empty, COVAR returns the #DIV/0! error value
• the covariance is given by the formula:

 

 where

	 x	̅ and y	̅

 are the sample means AVERAGE(array1) and AVERAGE(array2), and n is the sample size.

Please see our example below: 

The A to Z of Excel Functions: COVAR
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As mentioned in COVAR (above), the sign of the covariance therefore 
shows the tendency in the linear relationship between the variables.  
The magnitude of the covariance is not easy to interpret because it is 
not normalised and hence depends on the magnitudes of the variables.  

The normalised version of the covariance, known as the correlation 
coefficient, however, shows by its magnitude the strength of the linear 
relationship.

A distinction must therefore be made between:

• the covariance of two random variables, which is a population parameter that can be seen as a property of the joint probability distribution;   
 and 
• the sample covariance, which in addition to serving as a descriptor of the sample, also serves as an estimated value of the population   
 parameter.

This function returns the former (population) covariance, the average of the products of deviations for each data point pair in two data sets.  It is 
used to determine the relationship between two data sets.  For example, you can examine whether greater income accompanies greater levels of 
education.

The CORVARIANCE.P function employs the following syntax to operate:

CORVARIANCE.P(array1, array2)

The CORVARIANCE.P function has the following arguments:

• array1: this is required and represents the first cell range of integers
• array2: this is also required. This is the second cell range of integers.

It should be further noted that: 

• this function has replaced an older function (COVAR) and should provide improved accuracy and a name better reflecting its usage
• the arguments must either be numbers or be names, arrays, or references that contain numbers
• if an array or reference argument contains text, logical values, or empty cells, those values are ignored; however, cells with the value zero are   
 included
• if array1 and array2 have a different number of data points, COVARIANCE.P returns the #N/A error value
• if either array1 or array2 is empty, COVARIANCE.P returns the #DIV/0! error value
• the population covariance is given by the formula:

  

  where

	 	 x	̅ and y	̅

  are the sample means AVERAGE(array1) and AVERAGE(array2), and n is the population size.

Please see our example below: 

The A to Z of Excel Functions: COVARIANCE.P
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From above, we remarked that a distinction must be made between:

• the covariance of two random variables, which is a population parameter that can be seen as a property of the joint probability distribution; and 
• the sample covariance, which in addition to serving as a descriptor of the sample, also serves as an estimated value of the population parameter.

This function returns the latter (sample) covariance, the average of the products of deviations for each data point pair in two data sets.  It is used to 
determine the relationship between two data sets.  For example, you can examine whether greater income accompanies greater levels of education.

The CORVARIANCE.S function employs the following syntax to operate:

CORVARIANCE.S(array1, array2)

The CORVARIANCE.S function has the following arguments:

• array1: this is required and represents the first cell range of integers
• array2: this is also required. This is the second cell range of integers.

It should be further noted that: 

• this function has replaced an older function (COVAR) and should provide improved accuracy and a name better reflecting its usage
• the arguments must either be numbers or be names, arrays, or references that contain numbers
• if an array or reference argument contains text, logical values, or empty cells, those values are ignored; however, cells with the value zero are   
 included
• if array1 and array2 have a different number of data points, COVARIANCE.S returns the #N/A error value
• if either array1 or array2 is empty, COVARIANCE.S returns the #DIV/0! error value.

Please see my example below: 

The A to Z of Excel Functions: COVARIANCE.S
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Link to Others
These newsletters are not intended to be 
closely guarded secrets.  Please feel free 
to forward this newsletter to anyone you 
think might be interested in converting to 

“the SumProduct way”.

If you have received a forwarded 
newsletter and would like to receive 
future editions automatically, please 

subscribe by completing our newsletter 
registration process found at the foot of 
any www.sumproduct.com web page.

Any Questions?
If you have any tips, comments or queries 
for future newsletters, we’d be delighted 
to hear from you. Please drop us a line at 

newsletter@sumproduct.com.

Our Services
We have undertaken a vast array of 
assignments over the years, including:
·  Business planning
·  Building three-way integrated   
 financial statement projections
·  Independent expert reviews
·  Key driver analysis
·  Model reviews / audits for internal   
 and external purposes
·  M&A work
·  Model scoping
·  Power BI, Power Query & Power Pivot
·  Project finance
·  Real options analysis
·  Refinancing / restructuring
·  Strategic modelling
·  Valuations
·  Working capital management
If you require modelling assistance of any 
kind, please do not hesitate to contact us 
at contact@sumproduct.com.

Training
SumProduct offers a wide range of 
training courses, aimed at finance 
professionals and budding Excel experts. 
Courses include Excel Tricks & Tips, 
Financial Modelling 101, Introduction to 
Forecasting and M&A Modelling. 

Drop us a line at training@sumproduct.com 
for a copy of the brochure or download  
it directly from
http://www.sumproduct.com/training.

Check out our 
more popular 
courses in 
our training 
brochure:

There are over 540 keyboard shortcuts in Excel.  For a comprehensive list, please download our Excel file a
www.sumproduct.com/thought/keyboard-shortcuts. Also, check out our new daily Excel Tip of the Day feature on the 
www.sumproduct.com homepage.

Key Strokes
Each newsletter, we’d like to introduce you to useful keystrokes you may or may not be aware of.  This month, it’s time to combine 
CONTROL with ALT and SHIFT:

Keystroke What it does

CTRL + ALT + SHIFT + F2 Print

CTRL + ALT + SHIFT + F4 Close application

CTRL + ALT + SHIFT + F9 Recalculation (full build)

CTRL + ALT + SHIFT + TAB Outdent

Upcoming SumProduct Training Courses

Location Course Date Duration

Sydney Excel Tips and Tricks 8 Oct 2018 1 day

London Financial Modelling 8 - 9 Oct 2018 2 day

Sydney Financial Modelling 9 - 10 Oct 2018 2 day

Brisbane Excel Tips and Tricks 15 Oct 2018 1 day

Adelaide Financial Modelling 22 - 23 Oct 2018 2 day

Melbourne Excel Tips and Tricks 29 Oct 2018 1 day

Melbourne Financial Modelling 30 - 31 Oct 2018 2 day

Darwin Power Pivot, Power Query and Power BI 12 Nov 2018 1 day

Sydney Power Pivot, Power Query and Power BI 12 - 14 Nov 2018 3 day

Melbourne Excel Tips and Tricks 19 - 21Nov 2018 3 day

Sydney Excel Tips and Tricks 10 Dec 2018 1 day

Sydney Financial Modelling 11 - 12 Dec 2018 2 day

Sydney Power Pivot, Power Query and Power BI 17 - 19 Dec 2018 3 day
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